Sage 100 Contractor

BIL202: Manage Time and Materials Billing

CERTIFIED COURSE CURRICULUM
SAGE UNIVERSITY
IMPORTANT NOTICE

This document and the Sage 100 Contractor software may be used only in accordance with the Sage 100 Contractor End User License Agreement applicable to the Sage 100 Contractor software. You may not use, copy, modify, or transfer the Sage 100 Contractor software or this documentation except as expressly provided in the license agreement.

Visit Sage's training services Web site at www.SageU.com, call 1-877-724-3285, or e-mail us at traininginfo.cre@sage.com to learn about training classes that Sage adds throughout the year. Contact your business partner to learn about local training options.

Information in this document is intended solely as general information with respect to common business issues and is not to be construed as professional advice. Consult a tax or accounting professional for all tax and account related questions. THE INFORMATION HEREIN IS PROVIDED “AS IS” AND ALL WARRANTIES ARE EXPRESSLY DISCLAIMED, INCLUDING BUT NOT LIMITED TO ANY WARRANTY: OF MERCHANTABILITY; OF FITNESS FOR ANY PARTICULAR PURPOSE; OF NON-INFRINGEMENT OF ANY PROPRIETARY RIGHT OF ANY THIRD PARTY IN ANY COUNTRY; OTHERWISE ARISING OUT OF ANY PRODUCT, PROPOSAL, SPECIFICATION OR SAMPLE; AND ANY WARRANTY THAT THE DOCUMENT IS ERROR FREE. No license, express, implied, by estoppel or otherwise, to any intellectual property right is granted by this document. Sage Software may make changes to the information in this document at any time, without notice. Recipient is solely responsible for assessing the suitability of the information and assumes all risk of use.

© 2013 Sage Software, Inc. All rights reserved. Sage, the Sage logos, and the Sage product and service names mentioned herein are registered trademarks or trademarks of Sage Software, Inc., or its affiliated entities. All other trademarks are the property of their respective owners.

02/2013
# Contents

**Welcome** .......................................................... 5
- Course Pre-Requisites ........................................... 5
- Training Data for Lecture and Activities ...................... 5
- Conventions Used in This Workbook ........................... 7

**Manage Time and Materials Billing** .......................... 9
- What You Will Learn: ............................................ 9
- Job Setup .......................................................... 10
- Time and Materials Billing Setup ............................... 10
- Activity 1—Enter a T&M Billing ................................ 11
- Wage Rate Table Setup .......................................... 13
- Activity 2—Set Up Wage Rate Table ............................ 13
- Equipment Rate Table Setup .................................... 15
- Activity 3—Set Up a New T&M Billing ......................... 16
- Compute Invoice ................................................ 17
- Activity 4—Compute T&M Invoice ............................... 17
- Print Invoice ..................................................... 18
- Review and Edit Job Costs ...................................... 20
- Post Invoices ................................................... 21
- Activity 5—Post T&M Invoice .................................. 22
- T&M Reports .................................................... 22
- Recap Steps to Process a T&M Invoice: ....................... 23
- Void a T&M Invoice ............................................. 24
- Summary ......................................................... 25
Welcome

This handout has been designed for use in an instructor-led class for Sage 100 Contractor. Detailed instructions help you recall the procedures introduced by your instructor. Depending on how your training class is conducted, some sections may not be addressed. Refer to these sections in the future as you continue to work with the software.

Course Pre-Requisites

This course assumes that you have installed the Sage 100 Contractor software and opened the Sample Company. You should also have participated in the NCT102, NCT107, and NCT108 courses.

Training Data for Lecture and Activities

As your instructor demonstrates procedures in the software, he or she will access the training data set that has been used to capture application screens in this workbook. You will also use the training data set to complete the activities.

You can download the training data sets on the Sage University Web site (www.sageu.com) using the procedure explained on the next page.

Transactions in the Training Data Set

In certain cases, transactions in the data set that you use may show a different year than the illustrations in this book, or than the instructor shows in class. If your data set transactions show a different year, but all other details such as the account setup, vendor names, and jobs are identical, your data set will correspond to the materials in all respects but the date.

When you complete the activities that involve dates, you may see a different year in the instructions or screen shot than in your data. Use the appropriate year based on the data you are using for activities.

For example, if 2012 is the current year in your data and the activity prompts you to enter prior year information, enter a date in 2011. If the activity prompts you to enter current year information, enter a date in 2012.
If you already have an older version of the training data installed, you can upgrade it using the directions below to download the latest training data set.

If you prefer to use another data set for the activities, you may do so, but your results may not resemble the images you see in the workbook.

To Download the Training Data Set

1. In an Internet browser, go to http://sageu.com/sage100contractor.
2. In the right-hand area under QuickLinks, click Training Data.
3. Select the ReadMe File file for instructions on load the sample data.
4. Click the Download the Sample Company Training Data link.
5. Click Run to install the training data. If you see a security warning about the publisher, click Run.
6. Browse to your MB7 folder, then click Unzip, and then click OK.

Menu Paths

In this workbook, menu paths show you the steps required to start a task. This is a sample menu path:

4-Accounts Payable > 3-Vendor Payments > 2-Pay Vendors

Many modules and tasks are also available through Sage 100 Contractor Desktop. The Desktop has a tree structure that reflects the same logical progression as the steps of a menu path.

Where to Get Additional Information

Application Help Files

Each application contains an extensive Help system. The Help is your primary resource for reference and how-to information for all tasks. Help includes Contents, Index, and Search features that help you locate information quickly.

You can start Help in two easy ways:

- Select About this Window from the Help menu in any application.
- Press the F1 key on the window in any application.

Technical Support Knowledgebase

The Technical Support Knowledgebase contains the latest information about application features. You must have a current service plan to access the knowledgebase.
InfoCenter

Be sure to check the InfoCenter for product news, announcements, support, and training. Access the InfoCenter from Home and Resources tab > Customer Resources.

Submit Enhancement Requests

Do you have a suggestion for how we can improve our software? We want to hear your ideas! Open the Product Enhancement Request option from Home and Resources tab > Customer Resources. Ideas you enter will be submitted to our Product Management team.

Conventions Used in This Workbook

This workbook uses the following conventions:

- The names of screens, windows, fields, buttons, and other features displayed by the software are shown in bold type.
- Information you enter into the software is in bold type, as in the example below:
  
  Type Miscellaneous in the Amount Type field.
- Names of keys are shown in capitals; for example, ENTER, TAB. A plus sign (+) between two key names indicates that you should press both keys at the same time; for example, SHIFT + TAB.

  NOTE: This symbol draws your attention to information of particular interest.

  TIP: This symbol draws your attention to tips about using a helpful feature of the software.

  WARNING: This symbol draws your attention to information that is important because it can help you avoid a costly or time-consuming error.

  FOR MORE INFORMATION: This symbol draws your attention to a reference to another document or to another section in this document.
Manage Time and Materials Billing

The purpose of this class is to provide tools, guidelines and practice in setting up a Time and Materials (T&M) job and completing the T&M billing process.

What You Will Learn:

Create a T&M billing setup, wage and equipment rate tables; compute and print billing; review and edit job costs, post and void a T&M invoice.

- Set up T&M billing, including job, wage rates, and equipment
- Process T&M invoices

Why use Time and Materials (T&M) Billing?

To bill clients on a time and materials or cost-plus basis, plus overhead and profit. Sage 100 Contractor uses the job cost records as the basis for the billing amounts on the T&M invoices. When setting up a job for T&M billing, you can:

- Assign separate overhead and profit markup rates to each cost type.
- Assign a shown markup rate to each cost type.
- Assign a hidden markup rate to each cost type.
- Assign wage rate and equipment rate tables to the job.
Job Setup

In addition to the required (blue) entry fields, the Posting Information section must be completed with applicable information before a T&M invoice can be posted (minimum posting info needed is an income account).

Time and Materials Billing Setup

A billing setup must be completed for each T&M job so that the program knows the parameters for creating the amounts that will appear on the invoice. A combination of markups on various cost types and rate tables can be utilized.

Types of Markup

**Hidden Markup** – When invoice is calculated, the program adds the hidden markup to the job costs. The hidden markup does not appear on the T&M invoice.

**Shown Markup** – When invoice is calculated, the program adds the shown markup to the job costs. The shown markup appears as a separate total on the T&M invoice.

**Overhead Markup** – When invoice is calculated, the program totals the entire invoice plus any shown markup and adds the overhead markup. The overhead markup appears as a separate total on the T&M invoice.
**Profit Markup** – When invoice is calculated, the program totals the entire invoice, plus any shown and overhead markup, and adds the profit markup. The profit markup appears as a separate total on the T&M invoice.

**Sales Tax** – If a tax district has been indicated in the Job file, the program calculates the sales tax on the total invoice after all markups. The sales tax appears as a separate total on the T&M invoice.

---

**Activity 1—Enter a T&M Billing**

Enter a simple T&M billing setup.

1. Launch Sage 100 Contractor if you have not already done so, and select the Sample Company.

2. Open 3-10-1 T&M Billing Setup.

3. Enter Job number 225 in the data control box and set up minimum job information “on the fly”:
   - Job Name = T&M Class
   - Short Name = T&M
   - Job Status = Current
   - Income Acct = 4000
   - Department = 1
4. Click **Save**. The 3-5 Jobs window closes.

In 3-10-1 T&M Billing Setup, enter markups as shown below:

Next, we’ll save the billing setup as a template so that we can use it when setting up future T&M jobs.

1. On the File menu, click **Save as Template**. The Save Template dialog box opens.
2. In the Template Name box, enter **Typical T&M Setup** and then click **Save**. The Save Template box closes.

3. Back in 3-10-1, click **Save**.

Please return to the conference when you have completed this exercise.

**Wage Rate Table Setup**

You can assign a table of wage rates to a T&M job. The program will determine the billing amounts for the invoice using the wage rate table instead of the actual labor costs. You can also set a minimum amount of hours per employee to charge.

**Wage rates can be set up for:**

- Employees assigned to specific cost codes.
- Employees not assigned to specific cost codes.
- Cost codes not assigned to specific employees.
- No specific employee or cost code.

**NOTE:** The program does not create job costs for payroll until you final-compute timecards. By using the wage rate table you override the labor columns on the 3-10-1 T&M Billing Setup screen.

**Setup Screen**

![Setup Screen Image]

**Activity 2—Set Up Wage Rate Table**

Now set up T&M wage rates

1. Open 3-10-5 T&M Wage Rates.
2. Description = Standard Residential Rate.
3. Enter the remaining information in the 3-10-5 grid as shown above.
4. Save the new T&M Wage Rates record.

Please return to the conference when you have completed this exercise.

**What do the different wage rows mean?**

**Row 1** – When Mark is charged to 1000-General Requirements, the program knows to bill out his time at a specific rate.

**Row 2** – Anything else that Mark does is charged differently from his supervision rate.

**Row 3** – No matter who performs cost code 6130-Roof Framing, that employee is billed out at the appropriate rate based on the cost code.

**Row 4** – The program computes billing amounts for all remaining employees and cost codes.

The program will compute the wage rate grid in the following order:

1. Employees with cost codes
2. Employees with no cost codes
3. Cost codes with no employees
4. All remaining employees and cost codes in grid
Equipment Rate Table Setup

You can assign a table of equipment rates to a T&M job. The program will determine the billing amounts for the invoice using the equipment rates table instead of the actual equipment costs. You can also set a minimum amount of units per equipment to charge.

NOTE: If the equipment records contain rental-billing rates, the program creates the job cost with the rental-billing rate in the Billing Amount box. When the T&M invoice is calculated, the program replaces the billing amount with the rate from the equipment rate table. When using an equipment rates table, the hidden markup does not apply.

Equipment rates can be set up for:

- Equipment types
- Equipment
Activity 3—Set Up a New T&M Billing

Let’s set up a new T&M Billing for the Jimenez Burrito #8 job. We’ll use the template we created earlier.

1. Open 3-10-1 T&M Billing Setup.
2. In the data control box, enter 215. The job name for Jimenez Burrito #8 appears.
3. Click File > Load/Delete Template. The Template List dialog box opens.
4. Click to select Typical T&M Setup, and then click Load. The Template List dialog box closes.
5. Click the Wage Rate lookup arrow. The T/M Billing Employee Rates lookup window opens.
6. Double-click to select Standard Residential Rate. The Wage Rate lookup window closes.
7. Save this new record and then close the window.

Please return to the conference when you have completed this exercise.
Compute Invoice

After entering all payables, ledger entries and final computing payroll to date for a job, we are now ready to compute the invoice. The program computes billing amounts based on the job’s T&M billing setup for all job cost records assigned billing status 1-Open.

Activity 4—Compute T&M Invoice

1. Open 3-10-2 – Compute T&M Invoices.
2. In the Invoice Date field, enter today’s date.
3. Press ENTER to accept the default Invoice#.
4. In the Job# box, enter: 215.
5. Click Compute. A message appears informing you that the compute is complete.
6. Click OK.
7. Click Close.

Please return to the conference when you have completed this exercise.
Print Invoice

The computed invoice should be printed for review. There are many report types in the T&M report printing screen. The report chosen should be consistent with the billing setup for the job (by cost type or by cost code).
<table>
<thead>
<tr>
<th>Record#</th>
<th>Trans#</th>
<th>Date</th>
<th>Description</th>
<th>Cost Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>214</td>
<td>651557</td>
<td>05/07/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>35.83</td>
</tr>
<tr>
<td>215</td>
<td>651557</td>
<td>05/07/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>7.51</td>
</tr>
<tr>
<td>216</td>
<td>651557</td>
<td>05/07/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>4,194.45</td>
</tr>
<tr>
<td>217</td>
<td>651557</td>
<td>05/07/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>109.53</td>
</tr>
<tr>
<td>218</td>
<td>651557</td>
<td>05/07/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>109.78</td>
</tr>
<tr>
<td>219</td>
<td>616-01</td>
<td>05/14/2011</td>
<td>Freeman Hardware &amp; Steel Co.</td>
<td>15,643.50</td>
</tr>
<tr>
<td>220</td>
<td>96261</td>
<td>05/07/2011</td>
<td>Ramirez Materials</td>
<td>555.66</td>
</tr>
<tr>
<td>221</td>
<td>96261</td>
<td>05/07/2011</td>
<td>Ramirez Materials</td>
<td>461.05</td>
</tr>
<tr>
<td>229</td>
<td>96251</td>
<td>05/07/2011</td>
<td>Ramirez Materials</td>
<td>2,530.40</td>
</tr>
<tr>
<td>230</td>
<td>96275</td>
<td>05/14/2011</td>
<td>Ramirez Materials</td>
<td>4,737.53</td>
</tr>
<tr>
<td>231</td>
<td>96275</td>
<td>05/14/2011</td>
<td>Ramirez Materials</td>
<td>3,435.49</td>
</tr>
<tr>
<td>536</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>31.18</td>
</tr>
<tr>
<td>539</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>2,906.82</td>
</tr>
<tr>
<td>540</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>828.94</td>
</tr>
<tr>
<td>541</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>338.91</td>
</tr>
<tr>
<td>542</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>508.15</td>
</tr>
<tr>
<td>543</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>20.17</td>
</tr>
<tr>
<td>544</td>
<td>651298</td>
<td>05/24/2011</td>
<td>Ellis Lumber, Inc.</td>
<td>1,964.76</td>
</tr>
<tr>
<td>553</td>
<td>578R</td>
<td>06/01/2011</td>
<td>Sanders Valley Doors</td>
<td>5,066.14</td>
</tr>
</tbody>
</table>

Subtotal: 38,805.93

2 Labor

<table>
<thead>
<tr>
<th>Record#</th>
<th>Date</th>
<th>Description</th>
<th>Cost</th>
</tr>
</thead>
<tbody>
<tr>
<td>249</td>
<td>05/07/2011</td>
<td>Flatwork</td>
<td>240.00</td>
</tr>
<tr>
<td>250</td>
<td>05/09/2011</td>
<td>Flatwork</td>
<td>240.00</td>
</tr>
<tr>
<td>251</td>
<td>05/07/2011</td>
<td>Flatwork</td>
<td>240.00</td>
</tr>
</tbody>
</table>
Review and Edit Job Costs

When the T&M invoice has been computed, the job cost records display the computed billing amount information for each cost. By overriding the billing amounts you can:

- Increase or reduce the billing amount or quantity.
- Include a job cost on an invoice, but not bill for the work.
- Exclude a job cost from an invoice and not bill for the work.
- Create costs for work that does not cost you anything to produce.
- Change the taxability of a job cost record.

Invoices can be computed, printed, edited and re-computed until you are satisfied with the T&M billing.

Payroll Job Cost Record

Check Override to put the billing amount on the T&M invoice and ignore any other markups. Checking Override also allows you to select or clear the Subject to Sales Tax check box. When you indicate the tax district in the job record, the program includes the sales tax on the T&M invoice if this box is checked.
Material Job Cost Record

The final step in processing the T&M Invoice is posting. This step creates a simple Invoice at Receivable Invoices menu option 3-2, a Journal Transaction at menu option 1-3, and marks all job cost records associated with the billing with a status of Billed.

Reminder! Be sure to print a copy of the final T&M Billing prior to posting!
Activity 5—Post T&M Invoice

1. Return to desktop and select menu option 3-10-4 Post T&M Invoices.

2. Select Job 215-Senor Burrito #8.

3. Click Post Invoices.

Please return to conference when you have completed this exercise.

Posting Outcome:

- Simple invoice posted to A/R (3-2)
- General ledger transaction created (1-3)
- Job cost records marked “Billed” (6-3)

T&M Reports

- T&M Journal (3-10-7) – Similar to 6-1-2 Job Cost Journal, but lists the T&M billing amounts for cost records.

- T&M Summary (3-10-8) – Similar to 6-1-4 Job Summary Report, but compares budget (from 6-9 Proposal) to amounts billed.
Recap Steps to Process a T&M Invoice:

1. Enter Billing Setup at Menu 3-10-1.
2. Enter all costs that apply to this billing—AP Invoices, Payroll, General Ledger entries, etc.
4. Print Invoices – Menu 3-10-3.
5. Review Invoice and edit job costs if necessary (6-3).
6. Repeat above steps until you create the final invoice you want to send to client.
7. Print Final Invoice (3-10-3).
Void a T&M Invoice

When voiding a T&M invoice, you can reset the billing status of the job cost records.

1. Open Accounts Receivable Invoices - Menu Option 3-2.

2. Using the data control, select the T&M record. If an amount appears in the Paid box, reverse the payments.

3. On the Edit menu, click Void Invoice, and then click Yes to the box asking if you want to continue. A box will open asking Do you want to reset ‘Billing Status’ to Open on the job cost records?

4. To reset the billing status of the job cost records to 1-Open, click Yes. Resetting the billing status lets you re-invoice those job costs.

5. To retain billing status 3-Billed on the job cost records click No. The program leaves the job cost.

TIP: Train yourself to use the prompt line and online Help (F1). Backup often – Develop schedule for regular backups and always backup before performing certain tasks that affect all data (i.e. rebuilding indexes, etc.)
Summary

Did we accomplish our goals as outlined at the beginning of class?

We have covered the 3-10-1 Time and Materials Billing module, including setting up a job, wage rates, and equipment. We processed a T&M invoice from computing to posting.

Thank you for participating in this online class.